TITLE: DG-5.2: PROJECT STATUS REPORT GUIDELINE VERSION 3.0

AUTHORS:

Ken Jensen (Raytheon Information Solutions)

PROJECT STATUS REPORT GUIDELINE
VERSION HISTORY SUMMARY

<table>
<thead>
<tr>
<th>Version</th>
<th>Description</th>
<th>Revised Sections</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>No version 1.0.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2.0</td>
<td>No version 2.0</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>LIST OF ACRONYMS</td>
<td>5</td>
</tr>
<tr>
<td>1. INTRODUCTION</td>
<td>6</td>
</tr>
<tr>
<td>1.1. Objective</td>
<td>6</td>
</tr>
<tr>
<td>1.2. The Project Status Report</td>
<td>6</td>
</tr>
<tr>
<td>1.3. Background</td>
<td>8</td>
</tr>
<tr>
<td>1.4. Benefits</td>
<td>8</td>
</tr>
<tr>
<td>1.5. Overview</td>
<td>8</td>
</tr>
<tr>
<td>2. REFERENCE DOCUMENTS</td>
<td>9</td>
</tr>
<tr>
<td>3. STANDARD TABLE OF CONTENTS</td>
<td>10</td>
</tr>
<tr>
<td>4. SECTION GUIDELINES</td>
<td>12</td>
</tr>
<tr>
<td>4.1. Table of Contents</td>
<td>12</td>
</tr>
<tr>
<td>4.2. List of Figures</td>
<td>12</td>
</tr>
<tr>
<td>4.3. List of Tables</td>
<td>12</td>
</tr>
<tr>
<td>4.4. List of Acronyms</td>
<td>13</td>
</tr>
<tr>
<td>4.5. Section 1 – Introduction</td>
<td>13</td>
</tr>
<tr>
<td>4.6. Section 2 – Project Stakeholders</td>
<td>14</td>
</tr>
<tr>
<td>4.7. Section 3 – Project Lifecycle</td>
<td>15</td>
</tr>
<tr>
<td>4.8. Section 4 – Technical</td>
<td>16</td>
</tr>
<tr>
<td>4.9. Section 5 – Integrated Master Plan</td>
<td>16</td>
</tr>
<tr>
<td>4.10. Section 6 – Budget</td>
<td>17</td>
</tr>
<tr>
<td>4.11. Section 7 – List of References</td>
<td>18</td>
</tr>
<tr>
<td>4.12. Appendix</td>
<td>18</td>
</tr>
</tbody>
</table>
APPENDIX A. - EXAMPLES ............................................................................................................. 24

APPENDIX B - TEMPLATES ............................................................................................................... 25
  B.1 Cover Page Template: .............................................................................................................. 26
  B.2 Document Header Template: ........................................................................................................ 27
  B.3 Document Cover Page Footer Template: ....................................................................................... 27
  B.4 Document Footer Template: .......................................................................................................... 27
  B.5 Approval Page Template: .............................................................................................................. 28
  B.6 Version History Page Template: ................................................................................................ 29
  B.7 Figure Caption Template: ............................................................................................................. 30
  B.8 Table Title Template: .................................................................................................................. 30
  B.9 List of References Template: .......................................................................................................... 31
## LIST OF ACRONYMS

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CDR</td>
<td>Critical Design Review</td>
</tr>
<tr>
<td>CICS</td>
<td>Cooperative Institute for Climate Studies</td>
</tr>
<tr>
<td>CIMSS</td>
<td>Cooperative Institute for Meteorological Satellite Studies</td>
</tr>
<tr>
<td>CIOSS</td>
<td>Cooperative Institute for Oceanographic Satellite Studies</td>
</tr>
<tr>
<td>CIRA</td>
<td>Cooperative Institute for Research in the Atmosphere</td>
</tr>
<tr>
<td>CL</td>
<td>Check List</td>
</tr>
<tr>
<td>CLI</td>
<td>Check List Item</td>
</tr>
<tr>
<td>CMMI</td>
<td>Capability Maturity Model Integration</td>
</tr>
<tr>
<td>CPI</td>
<td>Cost Performance Index</td>
</tr>
<tr>
<td>CREST</td>
<td>Cooperative Remote Sensing and Technology Center</td>
</tr>
<tr>
<td>DG</td>
<td>Document Guideline</td>
</tr>
<tr>
<td>DPP</td>
<td>Development Project Plan</td>
</tr>
<tr>
<td>EPL</td>
<td>Enterprise Product Lifecycle</td>
</tr>
<tr>
<td>EVMS</td>
<td>Earned Value Management System</td>
</tr>
<tr>
<td>IMP</td>
<td>Integrated Master Plan</td>
</tr>
<tr>
<td>IMS</td>
<td>Integrate Master Schedule</td>
</tr>
<tr>
<td>IPT</td>
<td>Integrated Product Team</td>
</tr>
<tr>
<td>MOU</td>
<td>Memorandum of Understanding</td>
</tr>
<tr>
<td>NESDIS</td>
<td>National Environmental Satellite, Data, and Information Service</td>
</tr>
<tr>
<td>NOAA</td>
<td>National Oceanic and Atmospheric Administration</td>
</tr>
<tr>
<td>PAR</td>
<td>Process Asset Repository</td>
</tr>
<tr>
<td>PP</td>
<td>Project Proposal</td>
</tr>
<tr>
<td>PRG</td>
<td>Peer Review Guideline</td>
</tr>
<tr>
<td>QA</td>
<td>Quality Assurance</td>
</tr>
<tr>
<td>SG</td>
<td>Stakeholder Guideline</td>
</tr>
<tr>
<td>SOW</td>
<td>Statement of Work</td>
</tr>
<tr>
<td>SPI</td>
<td>Schedule Performance Index</td>
</tr>
<tr>
<td>SPSRB</td>
<td>Satellite Products and Services Review Board</td>
</tr>
<tr>
<td>SRR</td>
<td>System Readiness Review</td>
</tr>
<tr>
<td>STAR</td>
<td>Center for Satellite Applications and Research</td>
</tr>
<tr>
<td>TD</td>
<td>Training Document</td>
</tr>
<tr>
<td>TG</td>
<td>Task Guideline</td>
</tr>
<tr>
<td>WBS</td>
<td>Work Breakdown Structure</td>
</tr>
</tbody>
</table>
1. INTRODUCTION

The NOAA/NESDIS Center for Satellite Applications and Research (STAR) develops a diverse spectrum of complex, often interrelated, environmental algorithms and software systems. These systems are developed through extensive research programs, and transitioned from research to operations when a sufficient level of maturity and end-user acceptance is achieved. Progress is often iterative, with subsequent deliveries providing additional robustness and functionality. Development and deployment is distributed, involving STAR, the Cooperative Institutes (CICS, CIMSS, CIOSS, CIRA, CREST) distributed throughout the US, multiple support contractors, and NESDIS Operations.

NESDIS/STAR is implementing an increased level of process maturity to support the exchange of these software systems from one location or platform to another. The Project Status Report (PSR) is one component of this process.

1.1. Objective

The objective of this Document Guideline (DG) is to provide STAR standards for the PSR. The intended users of this DG are the personnel assigned by the Project Lead to the task of creating a PSR for the project.

1.2. The Project Status Report

The PSR is a formal, approved document used to manage and control the execution of the project. It documents the status of the project with respect to the project plan, which is documented in the Development Project Plan (DPP). The DPP (c.f. DG-5.1) documents the plan for the development, testing, review, and transition to operations for the project, including stakeholders, lifecycle, reviews, requirements, work products, resources, milestones, tasks, deliverables, schedule, and budget. The PSR should report the current status of each if these aspects of the plan, and identify risks associated with them.

Three versions of the PSR are produced during the STAR Enterprise Product Lifecycle (EPL)\(^1\).

\(^1\) For a description of the STAR EPL, refer to the STAR EPL Process Guideline (PG-1 and PG-1.A).
PSR v1r0, produced for the Gate 3 Review, reports the project status at the conclusion of Gate 3 Review preparation. At this stage, all planned activities of the Plan phase of the STAR EPL should have been completed, except for the Gate 3 Review itself.

PSR revisions (v1r1, v1r2, etc.) are produced as necessary to document changes to the project status that may occur after the Gate 3 Review, but prior to the commencement of the next EPL phase. Changes could result from actions generated by the Gate 3 Review.

PSR v2r0, produced for the Gate 4 Review, is a planned update that is intended to report the project status after the activities of the Design phase of the STAR EPL have been completed, except for the Gate 4 Review itself.

PSR revisions (v2r1, v2r2, etc.) are produced as necessary to document changes to the project status that may occur after the Gate 4 Review, but prior to the commencement of the next EPL phase. Changes could result from actions generated by the Gate 4 Review.

PSR v3r0, produced for the Gate 5 Review, is a planned update that is intended to report the project status after the activities of the Build phase of the STAR EPL have been completed, except for the Gate 5 Review itself.

PSR revisions (v3r1, v3r2, etc.) are produced as necessary to document changes to the project status that may occur after the Gate 5 Review, but prior to the delivery of the pre-operational system to operations. Changes could result from actions generated by the Gate 5 Review.

The PSR should be developed as a Microsoft Word document. Upon approval, the approved version of the PSR may be converted to an Adobe pdf file for storage in the project artifact repository.

The PSR will include an Appendix that reports the status of project risks and associated risk mitigation actions. This Appendix should be a Microsoft Excel file. Upon approval, the approved version of the PSR Appendix may be converted to an Adobe pdf file for storage in the project artifact repository.

---

2 Refer to the STAR EPL Process Guideline (PG-1 and PG-1.A) for a description of the STAR EPL gates and reviews.
1.3. Background

This DG defines guidelines for producing a PSR. This DG has been adapted from Capability Maturity Model Integration (CMMI) guidelines (CMMI-DEV-v1.2, 2006). It has been tailored to fit the STAR EPL process.

1.4. Benefits

A PSR developed in accordance with the standards in this DG assists the development team to provide necessary quality assurance of the products and product components. It is therefore a requirement that a PSR be developed in accordance with the guidelines in this document.

1.5. Overview

This DG contains the following sections:

- Section 1.0 - Introduction
- Section 2.0 - References
- Section 3.0 - Standard Table of Contents
- Section 4.0 - Section Guidelines
- Appendix A - Examples
- Appendix B - Templates
2. REFERENCE DOCUMENTS

All of the following references are STAR EPL process assets that are accessible in a STAR EPL Process Asset Repository (PAR) on the STAR web site:


PG-1: STAR EPL Process Guideline provides the definitive description of the standard set of processes of the STAR EPL.

PG-1.A: STAR EPL Process Guideline Appendix, an appendix to PG-1, is a Microsoft Excel file that contains the STAR EPL process matrix (Stakeholder/Process Step matrix), listings of the process assets and standard artifacts, descriptions of process gates and reviews, and descriptions of stakeholder roles and functions.

PG-2: STAR EPL Tailoring Guideline provides guidelines for determining a project’s define process by tailoring the STAR EPL standard set of processes.

PRG-5: Gate 3 Review Guidelines are the guidelines for the Gate 3 Review. It is useful for the PSR developers to understand what the reviewers will expect when reviewing the PSR.

CL-5: Gate 3 Review Check List is the check list for the Gate 3 Review. It is useful for the PSR developers to understand the specific Check List Items (CLI) that the reviewers of the PSR will be required to approve.

DG-0.1: STAR Document Style Guideline is a STAR EPL Document Guideline (DG) that provides STAR standards for the style and appearance of STAR documents developed as Microsoft Word files.

DG-5.1: Development Project Plan Guideline is a STAR EPL Document Guideline (DG) that provides STAR standards for the DPP.


TG-5: STAR EPL Step 5 Task Guidelines provides a description of standard tasks for process step 5, during which the PSR is initially developed.

TG-8: STAR EPL Step 8 Task Guidelines provides a description of standard tasks for process step 8, during which the PSR is updated to version 2.

TG-11: STAR EPL Step 11 Task Guidelines provides a description of standard tasks for process step 11, during which the PSR is updated to version 3.
3. STANDARD TABLE OF CONTENTS

LIST OF FIGURES
LIST OF TABLES
LIST OF ACRONYMS

1.0 INTRODUCTION

2.0 PROJECT STAKEHOLDERS
2.1 Stakeholder Involvement
   2.1.1 Suppliers
   2.1.2 Developers
   2.1.3 Operators
   2.1.4 Users
   2.1.5 Reviewers
   2.1.6 Management and Support
2.2 Stakeholder Agreements
2.3 Stakeholder Risks

3.0 PROJECT LIFECYCLE
3.1 Lifecycle Steps
3.2 Reviews
   3.2.1 Previous Reviews
   3.2.2 Current Reviews
   3.2.3 Future Reviews
3.3 Lifecycle Risks

4.0 TECHNICAL
4.1 Requirements
4.2 Work Products
4.3 Resources
4.4 Technical Risks

5.0 INTEGRATED MASTER PLAN
5.1 Milestones
5.2 Current Tasks
  5.2.1 Task N1.0
  5.2.2 Task N2.0
  5.2.3 Task N3.0
  ......................
5.3 Deliverable Items
5.4 IMP Risks

6.0 BUDGET
6.1 Cost
6.2 Funding
6.3 Earned Value
6.4 Budget Risks

7.0 LIST OF REFERENCES

A.0 APPENDIX
A.1 Candidate Risks
A.2 Candidate Actions
A.3 Established Risks
A.4 Established Actions
A.5 Risk History
4. SECTION GUIDELINES

This section contains the STAR guidelines for each section of the PSR.

The PSR should follow the STAR standard for style and appearance, as stated in DG-0.1.

4.1. Table of Contents

The Table of Contents can be inserted by using Word’s Insert → Reference → Index and Tables → Table of Contents function or by pasting the Table of Contents from this DG into your document and updating it for the section headers you make for your document. Use a page break if necessary to ensure that the Table of Contents appears at the top of a page.

4.2. List of Figures

A List of Figures should be provided after the Table of Contents. A page break should be used if necessary to ensure that the List of Figures appears at the top of a page. To create a List of Figures, use Word’s Insert → Reference → Index and Tables → Table of Figures function, selecting the “Table of Figures” Style. Alternatively, the List of Figures can be created by pasting the List of Figures for this DG into your document.

Figures should be created by using Word’s Insert → Picture → From File function or Word’s Insert → Object function. Figures should be numbered X.Y, where X is the main section number where the figure resides and Y = 1,N is the ordered number of the figure in the section. Figure captions should have Arial bold 12 point font, should be center justified, and should have a “Table of Figures” Style. A Figure Caption template is provided in Appendix B of this DG.

4.3. List of Tables

A List of Tables should be provided after the List of Figures. The List of Tables can appear on the same page as the List of Figures, with three blank lines separating them, provided both lists can fit on the same page. If both lists cannot fit on the same page, a page break should be used to ensure that the List of Tables appears at the top of a page.
To create a List of Tables, use Word’s Insert → Reference → Index and Tables → Table of Figures function, selecting the “Table - Header” Style. Alternatively, the List of Tables can be created by pasting the List of Tables for this DG into your document.

Tables should be created with the Table → Insert → Table function. Tables should be numbered X.Y, where X is the main section number where the table resides and Y = 1,N is the ordered number of the table in the section. Table titles should have Arial bold 12 point font, should be center justified, and should have a “Table - Header” Style. A Table Title template is provided in Appendix B of this DG. Table text should have Arial regular 10 point font.

4.4. List of Acronyms

The use of acronyms is encouraged. A two word or longer name for an item (e.g., Project Status Report) should be given an acronym (e.g., PSR) if the name is used more than once in the document. A List of Acronyms should be provided after the List of Tables. The List of Acronyms should be in alphanumeric order. Use the List of Acronyms in this DG as a template. A page break should be used if necessary to ensure that the List of Acronyms appears at the top of a page.

4.5. Section 1 – Introduction

The PSR shall include an Introduction Section. This section shall include

- A well-defined purpose and function for the document
- Specific intended user(s)
- How the intended user(s) should use the document
- A responsible entity for generating the document
- A responsible entity for review/approval of the document
- A responsible entity for storage, accessibility, and dissemination
- A brief overview of the contents of each main section
4.6. Section 2 – Project Stakeholders

Identify relevant stakeholders. For each stakeholder, note the rationale for their involvement, their roles and their responsibilities. There should be subsections for Stakeholder Involvement, Stakeholder Agreements, and Stakeholder Risks.

The subsection for Stakeholder Involvement should report the status of the involvement of each stakeholder with respect to their planned involvement. There should be separate subsections for each major type of stakeholder (Suppliers, Developers, Operators, Users, Reviewers, and Management and Support).

- A subsection for Suppliers would identify organizations that will be supplying hardware, software, personnel, and other resources (e.g., data). Adopt the information in DPP Section 3.1. Report the status of supplier involvement in the project, comparing this with the planned involvement.

- A subsection for Developers would identify the roles and key personnel for the team that will be developing the product processing system for transition to operations. Adopt the information in DPP Section 3.2. Report the status of developer involvement in the project, comparing this to the planned involvement.

- A subsection for Operators would identify all organizations and key personnel that will be responsible for operations and for maintenance. Adopt the information in DPP Section 3.3. Report the status of operator involvement in the project, comparing this to the planned involvement.

- A subsection for Users would identify all customers and end users of the project’s deliverable products. Adopt the information in DPP Section 3.4. Report the status of user involvement in the project, comparing this to the planned involvement.

- A subsection for Reviewers would identify the designated Review Lead and Review Team members for each project review. Adopt the information in DPP Section 3.5. Report the status of reviewer involvement in the project, comparing this to the planned involvement.

- A subsection for Management and Support would identify the management and support roles and key personnel. This includes project management, configuration management, data management, systems administration, and quality assurance roles. Adopt the information in DPP Section 3.6. Report the status of management and support involvement in the project, comparing this to the planned involvement.
The subsection for Stakeholder Agreements should report the status of compliance with stakeholder agreements (e.g., contracts, MOUs, Giver-Receiver lists).

The subsection for Stakeholder Risks should state each risk that is associated with stakeholder involvement and stakeholder agreements. Note that the risk assessment, risk mitigation plans, and description of associated risk mitigation actions will be reported in the PSR Appendix.

4.7. Section 3 – Project Lifecycle

Describe the product lifecycle that is planned for the project. Subsections should include Lifecycle Steps, Reviews, and Lifecycle Risks.

- The subsection for Lifecycle Steps should list the steps to be followed during the entire product lifecycle. Cut and paste the DPP Section 5.1 directly into this subsection.

- The subsection for Reviews should list the planned Technical Reviews and Gate Reviews. Adopt the information in DPP Section 5.2. There should be subsections for Previous Reviews, Current Reviews, and Future Reviews.
  - The subsection for Previous Reviews should note which reviews have already been conducted and closed. Note the status of each review, which should be “Closed Successfully.” If there have been no previous reviews, omit this subsection.
  - The subsection for Current Reviews should state the review objectives, entry criteria, and exit criteria for each review that is currently open. Usually, this will be the Gate Review for which the current version if the PSR is an artifact. Note the status of the review. The status should be “All review artifacts completed. Ready for the review to be conducted.”
  - The subsection for Future Reviews should report the status of preparation for each future review. Usually, this will consist of the status of selection of review teams. If there are no planned future reviews, omit this subsection.

- The subsection for Lifecycle Risks should state each risk that is associated with the lifecycle steps and reviews. Note that the risk assessment, risk mitigation plans, and description of associated risk mitigation actions will be reported in the PSR Appendix.
4.8. Section 4 – Technical

Report the status of the technical execution of the project. Subsections should include Requirements, Work Products, Resources, and Technical Risks.

- The subsection for Requirements should state all known project requirements. Adopt the information in DPP Section 6.1. Report the requirements status, i.e. which requirements are being met as planned and which are at risk of not being met.

- The subsection for Work Products should list the expected work products. Adopt the information in DPP Section 6.4. Report the status of the work products, i.e. which have been produced on schedule and which are behind schedule.

- The subsection for Resources should identify the specific resources that have been allocated to meet the requirements. This includes hardware and software resources, personnel, and data. Include resources (e.g., training, materials, time, funding) needed to ensure stakeholder involvement as planned. Adopt the information in DPP Section 6.5. In addition, report the status of the resource allocations, i.e. which resources have been provided as planned, which have been delayed, and which may not be provided at all.

- The subsection for Technical Risks should state each risk that is associated with the requirements, work products, and resources. Note that the risk assessment, risk mitigation plans, and description of associated risk mitigation actions will be reported in the PSR Appendix.

4.9. Section 5 – Integrated Master Plan

Report the status of the milestones, tasks, and deliverable items in the Integrated Master Plan (IMP). There should be subsections for Milestones, Current Tasks, Deliverable Items, and IMP Risks.

- The subsection for Milestones should list the major milestones. Adopt the information in DPP Section 7.1. Report the status of milestones that should have already been achieved. If possible, report the status of future milestones.

- The subsection for Current Tasks should describe the major tasks that should have been completed since the previous Gate Review. Each major task should be described in its own subsection. The description should include predecessor tasks, initiating criteria, subtasks, subtask assignees, work products, and accomplishment
criteria. Adopt the information in DPP Section 7.2. In addition, report the status of each major task.

- The subsection for Deliverable Items should list each separate item that is to be included in a delivery package to an identified customer or end user. The subsection should also list each separate item that is to be delivered to the project from a supplier. Adopt the information in DPP Section 4.3. Report the status of items that should have already been delivered. If possible, report the status of items that are planned for future delivery.

- The subsection for IMP Risks should state each risk that is associated with the milestones, tasks, and deliverable items. Note that the risk assessment, risk mitigation plans, and description of associated risk mitigation actions will be reported in the PSR Appendix.

4.10. Section 6 – Budget

Report the status of the project’s budget. Subsections should include Cost, Funding, Earned Value, and Budget Risks.

- The subsection for Cost should report the status of the costs incurred to date, comparing this with the cost schedule estimates in DPP Section 8.1.

- The subsection for Funding should report the status of the funding provided to date, comparing this with the funding schedule estimates in DPP Section 8.2. Compare the actual funding schedule to the actual cost schedule, thereby identifying the actual difference between the two. This difference (available funding minus the cost) is the “real cost margin”.

- The subsection for Earned Value should report the status of the project’s earned value, including earned value metrics (e.g. Cost Performance Index, Schedule Performance Index). Earned value is the planned (i.e., budgeted) cost for the work that has been accomplished. Earned value management is the process of monitoring a project’s accrual of earned value to ensure that project expenditures are producing the expected quantity and quality of work products.

- The subsection for Budget Risks should state each risk that is associated with the costs, funding, and earned value. Note that the risk assessment, risk mitigation plans, and description of associated risk mitigation actions will be reported in the PSR Appendix.
4.11. Section 7 – List of References

This section should consist of a List of References that includes all references cited in the document. Include all references deemed useful by the Product Team. References should be listed in alphabetical order. References that begin with an author list should begin with the last name of the lead author. A template is provided in Appendix B.

4.12. Appendix

The PSR Appendix is a Microsoft Excel file that reports the status of project risks and associated risk mitigation actions. A template for the PSR Appendix is provided as DG-5.2.A.

The standard PSR Appendix consists of six tabs. In addition to a Version History tab, there should be five description tabs (worksheets), Candidate Risks, Candidate Actions, Established Risks, Established Actions, and Risk History.

- The tab for Candidate Risks should report the status of risks that have been identified by the development team since the last review, and are being presented for review for the first time. Each candidate risk should be presented as a distinct row in the worksheet. The worksheet should include eight columns.
  - Column A, titled “Risk Number”, states the temporary ID number for a candidate risk. The convention is to use "Cn" where n is an integer from 1 to whatever.
  - Column B, titled “Risk Statement”, states a qualitative description of the risk. This should match a risk statement that is included somewhere in the main PSR document. Use descriptive language that conveys the meaning of the risk and states a consequence if the risk is not addressed. For example, "test data" is not sufficiently descriptive, but "Need to use simulated test data, because real and proxy data are not available. Simulated data is historically deficient in predicting real performance." is sufficiently descriptive.
  - Column C, titled “Origination”, identifies the person and/or organization that initially identified the risk.
  - Column D, titled “Category”, identifies the risk as either Technical, Schedule, or Budget.
Column E, titled “Mitigation Plan”, states the plan for reducing or eliminating the risk, typically as a bulleted list of steps.

Column F, titled “Probability”, states the quantitative assessment of the probability of occurrence, on a scale of 1 – 10, where 1 means 5%-15% probability, and 10 means > 95% probability. Risks with a probability of occurrence less than 5% are generally not reported.

Column G, titled “Severity”, states the quantitative assessment of the severity, or impact, of occurrence, on a scale of 1 – 10, where 1 means a minimal impact and 10 means inability to produce a required product.

Column H, titled “Risk Score”, states the overall quantitative risk assessment, which is the mathematical product of Probability and Severity.

The tab for Candidate Actions should report the status of actions that have been identified by the development team to mitigate candidate risks. Each candidate action should be presented as a distinct row in the worksheet. The worksheet should include eight columns.

Column A, titled “Risk Number”, states the temporary ID number for the associated candidate risk. This should match the appropriate risk number in Column A of the Candidate Risks tab.

Column B, titled “Risk Statement”, states a qualitative description of the associated candidate risk. This should match the appropriate risk statement in Column B of the “Candidate Risks” tab.

Column C, titled “Action”, states an action number and describes the action. The convention is “Cn.m - <description>”, where “Cn” matches the risk number in Column A, and m=1, 2, etc. For example, the third candidate action associated with risk "C4" would be numbered "C4-3".

Column D, titled “Closure Criteria”, states the criteria for considering the action to be closed.

Column E, titled “Closure Plan”, states the plan for meeting the action closure criteria, typically as a bulleted list of sub-actions.

Column F, titled “Assigned To”, identifies the stakeholder to whom the action has been assigned. If more than one stakeholder has been assigned the action, identify all of them.
Column G, titled “Closure Date”, states the date by which the action is expected to be closed.

Column H, titled “Status”, describes the progress made to date in completing the action and notes any issues that may affect the closure of the action.

- The tab for Established Risks should report the status of risks that have been selected from the list of Candidate Risks by a risk review team, usually at a Management or Technical Review. Each established risk should be presented as a distinct row in the worksheet. The worksheet should include at least nine columns.

  - Column A, titled “Risk Number”, states the permanent risk ID number. The convention is to number the risks in the order in which they are established, i.e. the first established risk is numbered "1", the second is numbered "2", etc.

  - Column B, titled “Risk Statement”, states a qualitative description of the risk. Usually, it is the same as the risk statement for the associated Candidate Risk, but the risk reviewers may at their discretion re-word the risk statement. If the risk originates with the reviewers, adopt the risk statement from the appropriate review report.

  - Column C, titled “Origination”, identifies the person and/or organization that initially identified the risk. If the risk originates with a review team (e.g. PDR), it is sufficient to state "PDR Review Team".

  - Column D, titled “Category”, identifies the risk as either Technical, Schedule, or Budget. Usually, this is the same as the risk category for the associated Candidate Risk, but the risk reviewers may at their discretion re-categorize the risk.

  - Column E, titled “Mitigation Plan”, states the plan for reducing or eliminating the risk, typically as a bulleted list of steps. Usually, this is the same as the mitigation plan for the associated Candidate Risk, but the risk reviewers may at their discretion revise the plan.

  - Column F, titled “Probability”, states the quantitative assessment of the probability of occurrence, on a scale of 1 – 10, where 1 means 5%-15% probability, and 10 means > 95% probability. The risk reviewers may at their discretion revise the estimate of the associated Candidate Risk. If this is a status update for an Established Risk, the reviewers should supply the estimate, basing their estimate on the assessment of the development team.

  - Column G, titled “Severity”, states the quantitative assessment of the severity, or impact, of occurrence, on a scale of 1 – 10, where 1 means a minimal
impact and 10 means inability to produce a required product. The risk reviewers may at their discretion revise the estimate of the associated Candidate Risk. If this is a status update for an Established Risk, the reviewers should supply the estimate, basing their estimate on the assessment of the development team.

- Column H, titled “Risk Score”, states the risk score, which is the mathematical product of Probability and Severity.

- Columns I, J, K, etc., titled “Risk Score History”, states the risk score as assessed by developers during the development lifecycle. A new column is created whenever the development team re-assesses the risk.

The tab for Established Actions should report the status of actions that have been selected from the list of Candidate Actions by a risk review team, usually at a Management or Technical Review. Each established action should be presented as a distinct row in the worksheet. The worksheet should include eight columns.

- Column A, titled “Risk Number”, states the permanent risk ID number. Adopt the number from Column A for the appropriate Established Risk.

- Column B, titled “Risk Statement”, is a statement of the associated Established Risk. Adopt the statement in Column B for the appropriate Established Risk.

- Column C, titled “Action”, states the permanent action ID number. The convention is to use "XXX-.i,j,k," where XXX is the standard acronym for the review at which the action is established (e.g., PDR), <i,j,k> is the review Check List Item (CLI) that the action applies to, and <i= 1 if this is the first action associated with the CLI, I=2 if it is the second action, etc.>. For example the third action that applies to CDR CLI 2.6.4 would have the permanent action number "CDR-2.6.4.3". Actions that do not apply to a specific CLI are numbered "XXX-l". For example, the third CDR action that does not apply to a specific CDR CLI would have the permanent action number "CDR-3".

- Column D, titled “Closure Criteria”, states the criteria for considering the action to be closed. Usually, this is the same as the closure criteria for the associated Candidate Action, but the risk reviewers may at their discretion revise the closure criteria.

- Column E, titled “Closure Plan”, states the plan for meeting the action closure criteria, typically as a bulleted list of sub-actions. Usually, this is the same as
the closure plan for the associated Candidate Action. The risk reviewers may at their discretion revise the closure plan, but it is usually left to the development team to establish and maintain the closure plan.

- Column F, titled “Assigned To”, identifies the stakeholder to whom the action has been assigned. If more than one stakeholder has been assigned the action, identify all of them.

- Column G, titled “Closure Date”, states the date by which the action is expected to be closed.

- Column H, titled “Status”, describes the progress made to date in completing the action and notes any issues that may affect the closure of the action.

- The tab for Risk History tracks the history of Established Risks by stating the assessed risk score at established project milestones. Each established risk should be presented as a distinct row in the worksheet. The worksheet should include up to nineteen columns.

  - Column A, titled “Risk Number”, states the permanent risk ID number. Adopt the number from Column A of the Established Risks tab.


  - Column C, titled “Status After G3R”, states the Risk Score that is assessed by the Gate 3 Reviewers in their report.

  - Column D, titled “Status At PRR”, states the Risk Score that is assessed by the developers in their PRR presentation.

  - Column E, titled “Status After PRR”, states the Risk Score that is assessed by the PRR Reviewers in their report.

  - Column F, titled “Status At PDR”, states the Risk Score that is assessed by the developers in their PDR presentation.

  - Column G, titled “Status After PDR”, states the Risk Score that is assessed by the PDR Reviewers in their report.

  - Column H, titled “Status At CDR”, states the Risk Score that is assessed by the developers in their CDR presentation.

  - Column I, titled “Status After CDR”, states the Risk Score that is assessed by the CDR Reviewers in their report.
o Column J, titled “Status At G4R”, states the Risk Score that is assessed by the developers in their G4R presentation.

o Column K, titled “Status After G4R”, states the Risk Score that is assessed by the Gate 4 Reviewers in their report.

o Column L, titled “Status At TRR”, states the Risk Score that is assessed by the developers in their TRR presentation.

o Column M, titled “Status After TRR”, states the Risk Score that is assessed by the TRR Reviewers in their report.

o Column N, titled “Status At CTR”, states the Risk Score that is assessed by the developers in their CTR presentation.

o Column O, titled “Status After CTR”, states the Risk Score that is assessed by the CTR Reviewers in their report.

o Column P, titled “Status At SRR”, states the Risk Score that is assessed by the developers in their SRR presentation.

o Column Q, titled “Status After SRR”, states the Risk Score that is assessed by the SRR Reviewers in their report.

o Column R, titled “Status At G5R”, states the Risk Score that is assessed by the developers in their G5R presentation.

o Column S, titled “Status After G5R”, states the Risk Score that is assessed by the Gate 5 Reviewers in their report.
APPENDIX A. - EXAMPLES

An example of a PSR that follows the STAR standards and guidelines will be developed and made accessible from the STAR Process Asset Repository (PAR).
APPENDIX B - TEMPLATES

This appendix contains templates for specific pages and sections of the DPP.
B.1 Cover Page Template:

In this template, <X> = 1.0 for version 1, <X> = 1.1 for version 1 revision 1, <X> = 2.0 for version 2 etc. <Project Name> should be the actual approved name of the Project.
B.2 Document Header Template:
In this template, \(<X> = 1.0\) for version 1, \(<X> = 1.1\) for version 1 revision 1, \(<X> = 2.0\) for version 2 etc.

In this template, \(<\text{Project Name}>\) should be the actual approved name of the Project.

In this template, \(<Y> = \) the actual page number.

In this template, \(<Z> = \) the actual total number of pages

---

B.3 Document Cover Page Footer Template:

---

B.4 Document Footer Template:

---
B.5 Approval Page Template:

In this template, <X> = 1.0 for version 1, <X> = 1.1 for version 1 revision 1, <X> = 2.0 for version 2 etc.  <Project Name> should be the actual approved name of the Project.

TITLE: <PROJECT NAME> PROJECT STATUS REPORT VERSION <X>

AUTHORS:

<Lead Author>

<Co-Author 1>

<Co-Author 2>

<etc.>

APPROVAL SIGNATURES:

_________________________________________<Actual Signature Date>
<br>Project Development Lead

_________________________________________<Actual Signature Date>
<br>Project Manager

_________________________________________<Actual Signature Date>
<br>AGENCY
### B.6 Version History Page Template:

In this template, `<Project Name>` should be the actual approved name of the Project.

---

**<PROJECT NAME>**

**PROJECT STATUS REPORT**

**VERSION HISTORY SUMMARY**

<table>
<thead>
<tr>
<th>Version</th>
<th>Description</th>
<th>Revised Sections</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>Created by &lt;Name of Developer(s)&gt; of &lt;Name of Developers’ Agency/Company&gt; for Gate 3 Review.</td>
<td>New Document</td>
<td>&lt;Actual date of Latest approval signature&gt;</td>
</tr>
<tr>
<td>1.1</td>
<td>Revised by &lt;Name of Developer(s)&gt; of &lt;Name of Developers’ Agency/Company&gt; to describe changes</td>
<td>&lt;applicable sections&gt;</td>
<td>&lt;Actual date of Latest approval signature&gt;</td>
</tr>
<tr>
<td>1.2</td>
<td>Revised by &lt;Name of Developer(s)&gt; of &lt;Name of Developers’ Agency/Company&gt; to describe changes</td>
<td>&lt;applicable sections&gt;</td>
<td>&lt;Actual date of Latest approval signature&gt;</td>
</tr>
<tr>
<td>2.0</td>
<td>Revised by &lt;Name of Developer(s)&gt; of &lt;Name of Developers’ Agency/Company&gt; for Gate 4 Review</td>
<td>&lt;applicable sections&gt;</td>
<td>&lt;Actual date of Latest approval signature&gt;</td>
</tr>
<tr>
<td>2.1</td>
<td>[As needed] Revised by &lt;Name of Developer(s)&gt; of &lt;Name of Developers’ Agency/Company&gt; to describe changes</td>
<td>&lt;applicable sections&gt;</td>
<td>&lt;Actual date of Latest approval signature&gt;</td>
</tr>
<tr>
<td>2.2</td>
<td>Ditto</td>
<td>Ditto</td>
<td>Ditto</td>
</tr>
<tr>
<td>etc.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
B.7 Figure Caption Template:

Figure 2.3 - <Figure caption in Arial regular 12 point font>

B.8 Table Title Template:

Table 4.5 - <Table title in Arial regular 12 point font>
B.9 List of References Template:


END OF DOCUMENT